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MATERIALS AND METHODS 

Materials 

Whatman No. 1 chromatography paper, lyophilized bovine serum albumin (BSA) and 

glycerol were purchased from VWR (Radnor, PA, USA). Gel blot paper (GB003, 15 cm × 

20 cm) was obtained from Whatman, Inc. (Sanford, ME, USA). Potassium periodate, 

poly(ethylene glycol) diacrylate (Mn=575) (PEGDA), triethanolamine (TEA), 1-vinyl-2-

pyrrolidinone (VP), eosin Y disodium salt, 2,4-dinitrophenylhydrazine, 10X phosphate 

buffered saline (PBS), phenolphthalein, Tween® 20 and sterile-filtered US-origin human 

serum (from human male AB plasma) were purchased from Sigma Aldrich (St. Louis, MO, 

USA) and used without further purification. Eosin 5-isothiocyanate (EITC) was purchased 

from Marker Gene Technology (Eugene, OR, USA). Tris(hydroxymethyl)aminomethane 

(Tris) and sodium chloride were purchased via VWR from Avantor Performance Materials  

(Center Valley, PA, USA), respectively. Lyophilized Plasmodium falciparum histidine-

rich protein 2 (PfHRP2) was purchased from CTK Biotech (San Diego, CA, USA). The 

anti-PfHRP2 IgG monoclonal antibodies (capture and reporter) were purchased from 

Arista Biologicals Inc. (Allentown, PA, USA). ABMAL-0444 (Clone 44) was used as the 

capture antibody and ABMAL-0445 (Clone 45) was used as the reporter antibody. 

UltraCruzTM Micro G-25 Spin Columns were purchased from Santa Cruz Biotechnology, 

Inc. (Santa Cruz, CA, USA) and PD-10 Desalting Columns were purchased from GE 

Healthcare Bio-Sciences (Pittsburgh, PA, USA). 

Preparation of aldehyde-functionalized paper 

Paper with aldehyde functional groups was prepared by soaking sheets (3” × 8”) of 

Whatman No. 1 chromatography paper in a 0.03 M KIO4 solution at 65 °C for 2 hours 

(Figure S1, A).1 After the reaction, the sheets were washed three times by dipping them in 

fresh deionized water (diH2O) for one minute each and pouring off the water at the end. 

After the last wash had been poured out, the sheets were blotted with paper towels and 

dried in a desiccator for at least 12 hours. Each dry sheet was taped to a regular 8” × 11” 

A4 printing paper and a wax mask containing circular wax-free regions (3 mm in diameter) 

was printed on them using a solid ink printer set to the default parameters for photo-quality 

printing. The A4 paper was removed and the printed sheets were placed in an oven (150 
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°C) for 90 seconds. As a result of the heat, the wax melted and spread through the thickness 

of the paper2 and created circular (2 mm in diameter) hydrophilic test zones separated by 

hydrophobic wax barriers(Figure S1, B). The presence of the aldehyde groups in the test 

zones allowed us to covalently immobilize amine-containing molecules (such as the anti-

PfHRP2 capture antibody in this study) to the surface of the paper through a Schiff-base 

linkage (Figure S1, C). The presence of the aldehyde groups in the test zones was 

confirmed by adding 2 μL of 2,4-dinitrophenylhydrazine and observing the change in color 

from yellow to orange (Figure S2). The sheets of aldehyde-functionalized paper were 

stored in a desiccator until use.  

Preparation of eosin-conjugated reporter antibody 

The method of conjugation of EITC to proteins has been described previously.3,4 EITC (1 

mg) was dissolved in 100 μL of DMSO. 20 μL of the above solution was mixed with a 400 

μL solution (5.3 mg/mL) of the reporter antibody in 0.1 M sodium bicarbonate buffer (pH 

9.0) to give a total reaction volume of 420 μL. The reaction mixture was protected from 

light and placed at 4 °C for five hours. During the reaction, the isothiocyanate functional 

group of EITC reacts with the amine group of the lysine residues of the antibody to form a 

thiourea bond (Figure S3, A). At the end of the reaction, the excess EITC was separated 

from the eosin-conjugated reporter antibody by size-exclusion columns with a Sephadex 

matrix (PD-10 Desalting Column and Micro G-25 Spin-Column).  

UV–visible absorbance spectroscopy was used to determine the average number of eosin 

molecules coupled to each reporter antibody molecule by taking an absorbance scan of the 

eosin-conjugated reporter antibody (Figure S3, B) and using the following equation: 

݊ாூ்஼ ݊ோ௘௣.஺௕. ൌ ൫ݏܾܣହଶହ ⁄ாூ்஼,ହଶହߝ ൯ ൣ൛ݏܾܣଶ଼଴ െ ൫ݏܾܣହଶହߝாூ்஼,ଶ଼଴ ⁄ாூ்஼,ହଶହߝ ൯ൟ ோ௘௣.஺௕,ଶ଼଴ൗߝ ൧ൗ⁄  

where ݊ாூ்஼is the number of molecules of eosin, ݊ோ௘௣.஺௕is the number of molecules of the 

reporter antibody, ݏܾܣଶ଼଴and ݏܾܣହଶହ are the measured absorbance values at 280 nm and 

525 nm, respectively, ߝாூ்஼,ହଶହ ൌ  90,200 M-1cm-1, ߝாூ்஼,ଶ଼଴ ൌ	 26,800 M-1cm-1 and 

ோ௘௣.஺௕,ଶ଼଴ߝ ൌ	280,200 M-1cm-1. The purified and characterized eosin-conjugated reporter 

antibody, containing an average of 7 eosin molecules per reporter antibody molecules, was 

diluted to make 50% v/v glycerol stock and stored in 10 μL aliquots at -20 °C until use. 



 5

Preparation of buffers and stock solutions 

100 mL of 10X PBS was diluted with 900 mL of diH2O to make 1X PBS solution. 1 g BSA 

was dissolved in 100 mL of 1X PBS to make a 1%w/v BSA solution (1% PBSA). 3.025 g 

Tris and 4.28 g NaCl were added to 450 mL diH2O and the pH was adjusted to 7.5 by 

adding 2N HCl to give a 50 mM Tris-Cl solution (1X TBS). 1 mg lyophilized PfHRP2 was 

dissolved in 200 μL of 2% PBSA to get 64 μM (5 mg mL-1) stock solution. 1.5 μL aliquots 

of the above solution were stored at -80 °C. The capture antibody, as received from the 

manufacturer, was stored in 10 μL aliquots at -20°C. 

Capture of PfHRP2 on paper  

The hydrophilic test zones of the aldehyde-functionalized paper were used for the detection 

of PfHRP2 using a sandwich immunoassay. For ease-of-use, strips of paper containing four 

test zones each (2.8 cm × 1.5 cm) were cut from the sheets of the oxidized chromatography 

paper. We used a flow-through system5 where both the top and the bottom surfaces of the 

test zones were open to the atmosphere. Therefore, during the incubation steps, the paper 

strips had to be suspended in air to prevent wicking of the solutions from the test zone. 

This layout was accomplished by placing each end of a paper strip on the lid of a 0.5 ml 

centrifuge tube that was fitted inside the frame of an empty pipette-tip box. Each tube 

extended upwards from the frame and created a raised support for the paper strip. The test 

zones on each paper strip were thus completely suspended in air between two supports. 

Multiple centrifuge tubes were fitted into one pipette-tip box to enable simultaneous 

incubation of 10 strips of paper (40 test zones) in every box. The boxes were kept humid 

by partially filling them with diH2O and keeping their lids closed during the incubation 

steps. The test zones to be prepared for the immunoassay were placed on supports, as 

described above, inside a humid pipette-tip box. A stock solution of the capture antibody 

was diluted to 67 μM (1 mg/ml) using 1X PBS and glycerol was added to a final 

concentration of 10%v/v. 2 μL of the above solution was added to each test zone and 

incubated overnight. After the incubation, the remaining solution of the capture antibody 

on the surface was wicked by bringing the bottom of the test zone in contact with a blotting 

paper. Each test zone was then washed with 40 μL of 1X PBS (two washes of 20 μL each 

(2 × 20μL)) by adding the wash solution to the top of the test zone and pressing the bottom 
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surface against a blotting paper to wick the solution. To block the excess aldehyde groups 

against non-specific binding of proteins, each test zone was then incubated with 10 μL of 

1X TBS in a humid pipette-tip box. The excess solution was wicked on the blotting paper 

and the test zones were washed with 40 μL of 1X PBS (2 × 20 μL). Following the wash, 

10 μL solution of PfHRP2 (prepared in either 1% PBSA or human serum) was pipetted on 

a test zone and incubated in a humid pipette-tip box for 30 minutes. For experiments in 

buffer, PfHRP2 solutions were prepared by adding 1 µL stock solution of PfHRP2 to 499 

µL of 1% PBSA to make a 130 nM solution - the highest concentration used in the 

experiments. The 130 nM solution was diluted further with 1% PBSA to get the lower 

concentrations. For experiments in human serum, the solutions were prepared as above 

using undiluted serum instead of PBSA. For negative control, a test zone was incubated 

with 10 μL of either 1% PBSA or undiluted human serum, without any PfHRP2, for the 

same duration. At the end of the incubation, the excess solution was wicked on a blotting 

paper and each test zone was washed with 40 μL of 1X PBS (2 × 20 μL). 

Detecting the presence of PfHRP2  

A 330 nM (50 μg/mL) solution of the eosin conjugated reporter antibody was prepared 

using 1% PBSA. Each test zone that was contacted with a sample (with or without PfHRP2) 

was incubated with 5 μL of the above solution in a humid pipette-tip box covered in foil 

for 30 minutes. At the end, the excess solution was wicked and each test zone was washed 

sequentially with PBST (1X PBS, 0.1%v/v Tween-20) (1 × 20 μL), 1X PBS (1 × 20 μL) 

and diH2O (1 × 20 μL). The presence of PfHRP2 was detected by measuring the 

fluorescence of eosin, followed by polymerization-based amplification.  

Fluorescence imaging 

Fluorescence microscopy was used to detect the presence of eosin on the surface of the 

paper during the development of the immunoassay. Each test zone was imaged using an 

Olympus IX81 microscope with a 4X objective lens, a 10X eyepiece lens, and a Semrock 

TxRed-4040C filter set using an exposure time of one second. Lumen 200 with a Prior 

Lumen Bulb (Item #P-LM200BI) was used as the source of light. The mean fluorescence 

intensity of each test zone was calculated by averaging the constituent pixel intensities 

using ImageJ (a public domain, Java-based image processing software). 
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Polymerization-based amplification (PBA) on paper 

An aqueous amplification solution containing 200 mM PEGDA, 150 mM TEA, 100 mM 

VP, 0.35 μM eosin Y, 1.6 mM phenolphthalein and 20 mM hydrochloric acid (HCl) was 

prepared.  During polymerization, TEA acts as co-initiator; the multifunctional monomer 

PEGDA is needed to form a crosslinked network; VP is a fast diffusing, low molecular 

weight monomer for improved kinetics; free eosin is used to overcome oxygen inhibition4,6 

and phenolphthalein and HCl are included for visualization. Phenolphthalein, a weak acid, 

is colorless at a pH less than 8. As the pH increases above 8, the equilibrium shifts in favor 

of the pink dianionic form (Figure S4). The amplification solution without HCl is basic 

with a pH of 9.3 because of the presence of TEA. If phenolphthalein is added to the 

amplification solution without pH adjustment, it is predominantly present in its dianionic 

state that absorbs strongly at the excitation wavelength of eosin, and thus competes with 

eosin for absorption of light during the initiation step. Therefore, HCl was added to adjust 

the pH of the solution to 7.9. At this pH, phenolphthalein is present in its acidic, colorless 

form and does not interfere with the absorption of light by eosin. We confirmed the state 

of phenolphthalein before and after adjustment of the pH using UV-visible spectroscopy 

(Figure S5). The concentration of phenolphthalein added to the solution was maximized 

within the limits of solubility to provide an intense colorimetric response. 

Each paper strip containing four test zones was cut to give four rectangular pieces (0.6 cm 

× 1.5 cm) containing one test zone in the middle of each piece. Each test zone was 

processed individually. The test zone was suspended in air by placing each end of its long 

side on a raised support built by attaching two smaller pieces of glass on top of a 

microscope slide. 20 μL of the aqueous amplification solution was added to the test zone 

and the slide was placed on a specially-designed frame such that the test zone was 

positioned at a fixed distance (∼9 cm) below an array of light-emitting diodes (LED) in an 

ampliPHOX® Reader (InDevR). The test zone containing the aqueous solution was then 

illuminated from above with a 522 nm light at 30 mW/cm2 for a specified duration. After 

irradiation was complete, the test zone was rinsed with diH2O from a spray bottle, followed 

by a diH2O wash (2 X 20 μL) on the blotting paper. 
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Visualization and imaging of interfacial hydrogels on paper  

2 μL of 0.5 M NaOH was added to a test zone for visualization of the result. The results 

were imaged with a smartphone, HTC One™ mini, using its camera in the ‘HDR’ mode 

with default settings. The phone was mounted on a ring stand to stabilize it. An ordinary 

desk lamp was used to shine light on the surface to keep the lighting conditions consistent 

at different times of the day (See Supplementary discussion, ‘Effect of ambient light during 

imaging’). A white sheet of A4 paper, with a slit cut through it for imaging, was also placed 

between the phone and the test surface to prevent glare from the overhead light and the 

lamp. The images were taken immediately after the addition of NaOH and transferred to a 

computer. These images were used without any modification.  

Optimization of the immunoassay 

We optimized the paper-based immunoassay using PfHRP2 solutions prepared in 1% 

PBSA. The effect of variables such the oxidation of the surface of the paper, the 

concentrations of capture and reporter antibodies and the incubation times for capture 

antibody, PfHRP2 and reporter antibody on the amount of surface-localized eosin was 

determined experimentally using fluorescence measurements (Figures S6-9). 

Quantification of colorimetric intensity and calculation of LoD 

ImageJ was used to quantify the intensity of the colorimetric results on paper. A detailed 

procedure for quantification is given in Table S1. The calculated colorimetric intensity 

values for each concentration of PfHRP2 and the p-values for a 1- tailed unpaired t-test 

between adjacent data points is given in Table S2. The analysis shows that all the 

concentrations of PfHRP2 that were tested were statistically distinguishable from the 

control surfaces and from each other. The colorimetric intensity data (y), calculated for the 

dose-response trials of PfHRP2 in a buffered solution, were fit to a sigmoidal curve using 

the function ‘nlinfit’ in Matlab. We used a four-parameter equation: ݕ ൌ

ሺܣ െ ሻܦ ሺ1 ൅ ሺܿ ⁄ܤ ሻ௡ሻ ൅ ⁄ܦ , where ܿ  is the concentration of PfHRP2, A is the lower 

asymptote, B, is the concentration in nM at inflexion point, n is the slope at inflexion point, 

and D is the upper asymptote.7 The R-squared value for the fitted curve was 0.996 and the 

fitted parameters with 95% confidence intervals were calculated as follows: A= 4.0 (-0.9, 

9.0), B =18.8 (14.3, 23.3), D=96.0 (85.4, 106.7), and n=1.4 (1.0, 1.8).  
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Storage experiments 

The storage experiments were performed by preparing surfaces as detailed in the 

manuscript. During these experiments, the surfaces were stored in a closed drawer We 

believe that for storage before polymerization, it is important to protect the surfaces from 

light by storing them in a closed drawer, an envelope, an opaque box or any other container 

because we have the photoinitiator on the surface. The initiator tolerates ambient light 

during the wash steps in the assay without any special care to shield it, but for storage on 

the days and month timescale, it becomes important to shield it from light.8 For storage 

after polymerization, even though the surfaces were stored in a closed drawer, we do not 

think that it is important to do so because for these surfaces only the phenolphthalein 

trapped in the hydrogel is important, and phenolphthalein is stable under ambient light. 
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Supplementary Figure S1: Preparation of aldehyde-functionalized hydrophilic test zones 

on paper for covalent immobilization of amine-containing molecules (A) An aqueous 

solution of potassium periodate was used to selectively oxidize the C2-C3 vicinal hydroxyl 

groups in the glucose unit of cellulose to give a dialdehyde product (aldehyde-

functionalized paper). (B) The modified paper was printed with wax and heated to create 

hydrophilic test zones surrounded by hydrophobic wax barriers. (C) Amine groups on a 

molecule (e.g. amine groups of the lysine residues of an antibody) can form a Schiff base 

linkage with the aldehyde groups to covalently immobilize the molecules on the surface of 

the paper. 
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Supplementary Figure S2: Characterization of aldehyde-functionalized paper using 2,4 

dinitrophenylhydrazine (2,4-DNP). (A) Schematic of the reaction of 2,4-DNP with an 

aldehyde moiety of the aldehyde-functionalized paper. (B) Results after unmodified and 

aldehyde-functionalized paper are reacted with 2,4-DNP. Aldehyde-functionalized paper 

reacts to give a deep orange color and unmodified paper remains yellow. 
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Supplementary Figure S3: Preparation and characterization of eosin-modified reporter 

antibody (A) Schematic of the reaction between an isothiocyanate group on eosin 5-

isothiocyanate and an amine group of a lysine residue of the reporter antibody to form a 

thiourea bond. (B) A typical UV-visible absorption spectrum for purified, eosin-conjugated 

anti-PfHRP2 reporter antibody. 
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Supplementary Figure S4: Equilibrium between colorless and pink isomers of 

phenolphthalein as a function of pH.  
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Supplementary Figure S5: UV-visible absorption spectrum of aqueous amplification 

solution with (dashed line) and without (solid black line) pH adjustment. 
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Supplementary Figure S6: Mean fluorescence intensity values for the detection of 

PfHRP2 in a buffered solution on aldehyde-functionalized and unmodified Whatman No. 

1 chromatography paper. The concentration (67 μM) and the incubation time (overnight) 

of the capture antibody, the concentration (130 nM) and the incubation time (30 minutes) 

of PfHRP2, and the concentration (330 nM) and the incubation time (30 minutes) of the 

eosin-conjugated reporter antibody were kept the same for both surfaces. The aldehyde-

functionalized paper serves as a better surface for the detection of PfHRP2 (with higher 

specific signal from surfaces that were contacted with PfHRP2 and lower non-specific 

signal from negative controls) compared to the unmodified paper. Each bar is an average 

of four replicates and error bars denote standard deviation. 
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Supplementary Figure S7: Mean fluorescence intensity values for the detection of 

PfHRP2 on paper in which the concentration and the incubation time of the capture 

antibody were varied. (A) Different concentrations of capture antibody were incubated 

overnight (15 hours).  (B) 67 μM capture antibody was incubated for different times. The 

concentration (130 nM) and the incubation time (30 minutes) of PfHRP2 and the 

concentration (330 nM) and the incubation time (30 minutes) of the eosin-conjugated 

reporter antibody were kept the same for both assays. Each data point is an average of three 

replicates and error bars denote standard deviation. The fluorescence intensity of surfaces 

that were contacted with samples without any PfHRP2 was measured as a negative control 

(182±18 RFU) for non-specific binding of the eosin-conjugated reporter antibody to the 

capture antibody. The fluorescence intensity of the surfaces that were not contacted with 

capture antibody, but were incubated with 130 nM PfHRP2 and 330 nM eosin-conjugated 

reporter antibody was also measured (273±72 RFU) as a negative control for non-specific 

binding of PfHRP2 to the surface of the paper without any capture molecules. 67 μM was 

chosen as the concentration of the capture antibody for the assays because it gave the 

highest fluorescent signal. For the incubation time of the capture antibody, the 

improvement in signal was minimal for an increase in time from 3 hours to 15 hours.  
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Supplementary Figure S8: Mean fluorescence intensity values for the detection of 

PfHRP2 on paper in which the concentration and the incubation time of the eosin-

conjugated reporter antibody were varied. The concentration (67 μM) and the incubation 

time (overnight) of the capture antibody and the concentration (130 nM) and the incubation 

time  (30 minutes) of PfHRP2 were kept the same for both assays. (A) Different 

concentrations of eosin-conjugated reporter antibody were incubated for 30 minutes. (B) 

330 nM eosin-conjugated reporter antibody was incubated for different times. Each data 

point is an average of three replicates and error bars denote standard deviation. 

Fluorescence intensity of the surfaces that were prepared by an overnight incubation of 67 

μM capture antibody were reacted with 1% PBSA without any PfHRP2 and contacted with 

the highest concentration of the eosin-conjugated reporter antibody (330 nM) for the 

longest incubation time (60 minutes) as a negative control (226±16 RFU)) for non-specific 

binding of the reporter antibody to the capture antibody. Increasing the concentration of 

the reporter antibody significantly increases the fluorescent signal. Therefore, the highest 

possible concentration of the reporter antibody (330 nM) was used in the assays. The effect 

of the increase in incubation time of the reporter antibody was seen up to 30 minutes after 

which an increase in the incubation time led to a minimal increase in the fluorescent 

intensity.  
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Supplementary Figure S9: Mean fluorescence intensity values for the detection of 

PfHRP2 on paper in which sample (containing PfHRP2) incubation time was varied. 67 

uM capture antibody was incubated overnight (15 hours). Next, a sample containing 130 

nM PfHRP2 was incubated for different times, following which 330 nM eosin-conjugated 

reporter antibody was incubated for 30 minutes. Each data point is an average of three 

replicates and error bars denote standard deviation. The effect of the incubation time of 

PfHRP2 was seen up to 10 minutes after which an increase in the incubation time led to a 

minimal increase in the fluorescence intensity. 
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Supplementary Table S1: Procedure for quantification of colorimetric result using ImageJ. 

Task Command Results 

1. Open the image in ImageJ 
 

 

 

2. Convert the image into 
red, green and blue 
channels  

Image ->Type -> RGB 
stack 

3. Select the blue channel 
and threshold it. Select 
upper and lower limits to 
ensure that only the test 
zone is selected. Do not 
select “apply” 

(Click on blue channel to 
select it) 

Image ->Adjust -> 
Threshold 

  

4. Measure the average 
intensity of the area that is 
thresholded 

Analyze -> Measure 

5. (a) Select the area that is 
thresholded in the blue 
channel to define the 
boundary of the test zone  
(b) Remove the threshold 
from the image and select 
the green channel  

(a) Edit -> Selection -> 
Create selection 

 

(b) Image ->Adjust -> 
Threshold ->Reset 

(Click on the green 
channel to select it) 

 

6. Measure the average 
intensity of the test zone in 
the green channel 

Analyze -> Measure 

7. Subtract the average 
intensity in the green 
channel from the average 
intensity in the blue 
channel 
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Supplementary Table S2: Calculated colorimetric intensity values for each concentration 

of PfHRP2 (n=8). The p-values shown in the table are calculated from a one-tailed unpaired 

t-test between the colorimetric intensity values of surfaces at the given concentration of 

PfHRP2 and the colorimetric intensity values of surfaces tested with the preceding 

concentration of PfHRP2.  

Concentration 
of PfHRP2 

(nM) 

Mean 
colorimetric 
intensity 

Standard 
deviation

p‐value 
(1‐tailed 
unpaired 
t‐test) 

0  6.0  4.1   

1.3  3.5  2.4  0.0800 

2.3  6.9  2.8  0.0111* 

4.1  14.2  4.5  0.0011* 

7.2  26.7  5.8  0.0002* 

13  34.4  9.1  0.0334* 

23  57.3  11.9  0.0004* 

41  74.3  8.7  0.0032* 

72  83.8  4.6  0.0105* 

130  90.4  4.8  0.0071* 

*p-value is less than 0.05 and indicates a statistically significant result 
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Supplementary Table S3: A comparison of polymerization-based amplification (PBA) 

with existing colorimetric methods for immunoassays on cellulose.  

Colorimetric detection 
method 

Contribution to total number of 
assay steps  

Contribution to assay 
time* 

Polymerization-based 
amplification 

3 (Polymerization, rinse, addition 
of NaOH) 

2-2.5 mins# 

Enzymatic reactions 1 (Addition of substrate)  30 mins5,9 

Gold nanoparticles with 
enhancement 

1 (Addition of enhancement 
solution) 

30 mins9 

*All the studies referred to in this column used a flow-through system. Therefore, the 
contribution of the detection method to the overall assay time can be directly compared 
with our system. 
# This time includes all three PBA steps – polymerization (൑90 s), rinsing to remove 
unreacted solution (~30 - 60 s), and addition of NaOH (negligible; color change is 
instantaneous upon addition of NaOH). 

Note: A color development time of 2-2.5 minutes compared to a time of 20-30 minutes 

has important implications. Because there is an end time beyond which the results of the 

enzymatic and gold nanoparticle-based tests cannot be trusted,10 if a user walks away 

from the test (due to long color development times) and returns only a few minutes late, 

the test can become invalid (false positive). Users may be less likely to walk away in 2-

2.5 minutes. Moreover, if an automated timer is used for PBA, such that the light 

automatically shuts off after a fixed time, the reaction will stop with the light and the user 

can come back and perform the rinse and the visualization step at a later time. The 

visualization itself is instantaneous upon addition of NaOH, and storage experiments 

showed no ‘end’ time (up to four months) after which the test became invalid. 
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SUPPLEMENTARY DISCUSSION 

Eosin-mediated polymerization reaction and visualization of interfacial hydrogels on 
paper 

This section summarizes the current understanding of the mechanism for co-

polymerization of the acrylate monomers, PEGDA and VP, using an eosin/tertiary amine 

photoinitiation system. The structures of the important reaction components are shown in 

Figure DS1. 

 

Supplementary Discussion Figure DS1: (A) eosin Y, (B) triethanolamine (TEA), (C) 1-

vinyl-2-pyrrolidinone (VP), and (D) poly(ethylene glycol) diacrylate (PEGDA) 

The use of xanthene dyes in photoinitiation systems has been studied extensively.11–13 The 

eosin/tertiary amine photoinitiation system in particular has historically been used for the 

polymerization of acrylate monomers for encapsulation of cells.14 When irradiated with 

green light, the excited triplet state of eosin (E*) accepts an electron from TEA. The TEA 

radical cation then loses a proton to generate the initiating TEA radical.13,15,16 The initiating 

radical can then react with an acrylate monomer (PEGDA or VP) to generate a propagating 

polymer chain. The termination of the polymer chains can occur either through 

combination or disproportionation reactions between the radical ends of the growing 

polymer chains. The initiating radical or the radical terminus of a growing polymer chain 

can also react with the dissolved oxygen present in the system to generate less reactive 

peroxide radicals. The peroxide radicals are unreactive towards further propagation and 
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thus terminate the growth of the polymer chains.17 Therefore, the free radical 

polymerization reactions in PBA were previously carried out under oxygen-free conditions 

by purging the system with an inert gas.18 However, Avens et al. recently proposed a 

mechanism by which a series of disproportionation termination reactions between the semi-

reduced eosin (E-H) radicals and peroxide radicals can cyclically regenerate eosin and the 

polymerization reaction can proceed in the presence of oxygen.6 This observation was also 

used to develop a PBA system that is capable of generating interfacial polymers without 

purging the system.4 The reaction kinetics of the eosin-based polymerization reaction in 

the presence of oxygen is still under active investigation and the reaction scheme presented 

in Figure DS2 consists of reactions that are thought to be the most important. 

 

Supplementary Discussion Figure DS2: Eosin-mediated polymerization: initiation, 

propagation, inhibition, termination and eosin re-generation reactions 
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The hydrogel formed by polymerization of acrylate monomers is transparent; therefore, a 

visualization strategy is needed to detect the presence of the interfacial hydrogel in assays 

using PBA. On bioactive glass surfaces, the hydrogels are typically swollen with a dye 

solution. This technique results in high-contrast between the hydrogel and the bare glass 

because the dye swells into the hydrogel but does not stain the surface of the glass. With 

paper, however, the dye solution adheres to the surface non-specifically even after 

thorough washing. Therefore, it is difficult to differentiate the hydrogel from the 

background of the paper, which would increase the likelihood of false positive 

interpretations in a diagnostic device.  

 

Supplementary Discussion Figure DS3: Visualization on paper (A) with hydrogel, and 

(B) without hydrogel, by swelling with a dye solution. The dye solution adheres non-

specifically to paper, thus the colorimetric result is similar regardless of the presence of the 

hydrogel. 

 

 

 

 

 

 

 

 

A) Paper surface with hydrogel 

B) Paper surface without hydrogel 
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Stability of color on paper after addition of NaOH for visualization 

The change in color of phenolphthalein that gets trapped in the cross-linked hydrogel 

formed at the surface of a paper test zone occurs immediately upon the addition of NaOH 

to the surface (t=0, Figures DS4 and DS5) and allows a user to interpret the result of the 

test without any waiting time. As time increases, the color becomes progressively faint and 

eventually disappears. The fading is primarily due to two reasons, evaporation of the NaOH 

solution (phenolphthalein is colorless in dry state), and diffusion of phenolphthalein out of 

the hydrogel. The time required for the color to fade depends on the initial intensity of the 

colorimetric response that is dependent on the amount of phenolphthalein trapped in the 

hydrogel, which in turn depends on the thickness of the hydrogel. For thick hydrogels 

formed on the surfaces contacted with a high concentration of PfHRP2 (130 nM), the pink 

color persisted for at least 10 minutes until the NaOH solution evaporated (Figure DS4, 

A). We prevented evaporation after addition of NaOH to the test zone by tightly wrapping 

a piece of scotch tape on both sides of the paper to completely seal it (lamination). Under 

this condition, the color persisted for more than 60 minutes (Figure DS4, B). For thin 

hydrogel films formed from a lower concentration of PfHRP2 (13 nM), the diffusion of 

phenolphthalein from the hydrogel occurred before the evaporation of the NaOH solution 

(Figure DS5, A) and the color faded within 3 minutes of adding NaOH. For this case, 

lamination of the paper extended the stability of the color to more than 20 minutes (Figure 

DS5, B) by limiting the spread of the NaOH solution. 
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Supplementary Discussion Figure DS4: Images showing the colorimetric response for 

detection of 130 nM PfHRP2 on paper (A) with, and (B) without lamination after 

addition of 2 µL NaOH at t=0 minutes.      

 

Supplementary Discussion Figure DS5: Images showing the colorimetric response for 

detection of 13 nM PfHRP2 on paper (A) with, and (B) without lamination after addition 

of 2 µL NaOH at t=0 minutes. 
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Effect of ambient light during imaging  

We observed that uniform lighting during image capture was important for reproducibility 

in image quantification for images taken at different times of the day. Different lighting at 

the time of image capture resulted in different colorimetric intensity values for the same 

concentrations of PfHRP2. Using an ordinary desk lamp to illuminate the paper surface 

during image capture solved the problem of non-uniform light and gave reproducible 

colorimetric intensity values. 

 Paper surfaces that were prepared by overnight incubation of 67 μM capture antibody were 

contacted with different concentrations of PfHRP2, ranging from 1.3 nM to 130 nM, in 1% 

PBSA. Negative test surfaces were contacted only with 1% PBSA. All of the above 

surfaces were contacted with 330 nM eosin-conjugated reporter antibody and imaged for 

fluorescence. The surfaces were then contacted with the aqueous amplification solution 

and irradiated with light for 90 seconds. They were washed to remove the unreacted 

monomer and visualized with 2 μL of 0.5 M NaOH. The surfaces were imaged with or 

without the use of a desk lamp immediately after addition of NaOH and the color intensity 

was quantified using ImageJ. The procedure outlined above was repeated independently 

on three different days and the results were compared. Even though the fluorescence 

intensity data gave good agreement, indicating similar photoinitiator density on the 

surfaces that were contacted with same concentrations of PfHRP2 in independent trials, 

non-uniformities in light during imaging (due to differences in ambient light at different 

times of the day) led to dramatically different color intensity values (Figure DS6). If the 

light falling on the surfaces during imaging was controlled by the use of an ordinary desk 

lamp, the color intensity data showed good agreement between independent trials (Figure 

DS7). 
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Supplementary Discussion Figure DS6: Images for a dose-response trial done on two 

different days, (A) and (B). The images in (A) were taken by illuminating the surfaces 

with an ordinary desk lamp and images in (B) were taken under ambient light. For (B), 

the surfaces with PfHRP2 concentration of 0-13 nM were imaged during the day and 

surfaces with PfHRP2 concentration of 23-130 nM were imaged after dark. (C) A 

comparison of fluorescence measurements taken before polymerization showed good 

agreement in the amount of surface-bound eosin for same concentrations of PfHRP2 

tested on different days. (D) Quantification of the colorimetric intensity using the 

images shown in (A) and (B) showed a dramatic difference in values for surfaces that 

were imaged after sunset.  
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Supplementary Discussion Figure DS7: Images for a dose-response trial done on two 

different days (A) and (B). The images for both trials were taken by illuminating the 

surfaces with an ordinary desk lamp to control the effect of differences in ambient light. 

(C) A comparison of fluorescence measurements taken before polymerization showed 

good agreement in the amount of surface-bound eosin for same concentrations of PfHRP2 

tested on different days. (D) Quantification of the colorimetric intensity using the images 

shown in (A) and (B) showed good agreement between results on different days when the 

effect of non-uniformities in ambient light was controlled.  
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Effect of a complex sample matrix on the performance of PBA on paper and 
reproducibility of the illumination time 

Detection of PfHRP2 in human serum rather than in a buffer solution did not increase the 

visual LoD (Figure 3). However, in order to differentiate between the positive samples and 

the negative controls, the illumination time for the polymerization reaction had to be 

reduced from 90 seconds for surfaces contacted with samples prepared in buffer to 50 

seconds for surfaces contacted with samples prepared in serum. To account for this 

observed decrease, both positive and negative surfaces contacted with samples prepared 

separately in serum and buffer were compared using fluorescence. It was observed that the 

fluorescence intensity of the surfaces contacted with human serum was higher than the 

fluorescence intensity of the surfaces contacted with a buffer solution (Figure DS8) 

because of higher non-specific binding of proteins in the serum to the capture antibody 

and/or the surface of the paper. The presence of a higher eosin density on the negative 

serum samples required a decrease in the illumination time from 90 seconds to 50 seconds 

to prevent bulk polymerization on these surfaces.4  

 

Supplementary Discussion Figure DS8:  Mean fluorescence intensities of surfaces tested 

with dilutions of PfHRP2 prepared in buffer and in human serum.  
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For surfaces that were used to detect PfHRP2 in a buffer solution, an illumination time of 

90 seconds was reproducibly used to differentiate between negative controls and positive 

samples.  We did five independent dose-response trials for PfHRP2 detection in buffer 

samples and tested the effect of, i) two different batches of paper that were oxidized 

independently, and ii) two different lots of capture antibody purchased from the same 

manufacturer. In addition, the amplification solution, the dilutions of PfHRP2 and the 

dilution of the eosin-conjugated reporter antibody were freshly prepared for each trial. We 

found that the required illumination time remained consistent across all trials. Therefore, 

the polymerization reaction is not sensitive to minor day-to-day variability.   
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